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- محتویات بسته۱
Mini MKII_LCپروگرامر •

 اتصال پروگرامر به میکروکنترلرISPکابل•
 (به منظور پایین نگاه داشتن قیمت نهایی، این کابل ارائه نمی شJJود. اتصال پروگرامر به کامپیوترUSBکابل •

Microشما می توانید از هر کابل نوع   USBدیJJمند اندرویJJراه هوشJJای همJJای تلفن هJJل دیتJJاز جمله کاب 
استفاده نمایید)

(به منظور پایین نگاه داشتن قیمت نهایی، ایJJن کابJJل ارائه نمی شJJود. آخریJJن نسJJخه از لوح فشرده نرم افزار•
نرم افزار اتمJل اسJJتودیو و یJا فلیJJپ، بJه رایگJJان از وب سJJایت شJJرکت میکروچیJJپ قابJل دانلJJود می باشJJد.
نرم افزارهایی از قبیل کدویژن و بسکام نیز بر روی وب سایتهای دانلود ایرانی موجود بوده و به راحJJتی قابJJل

دریافت می باشد)

 اقلم حذف شده، به صورت جداگانه قابل سفارش و خرید از تولید کننده می باشند.تذکر:
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Mini MKII_LC- مشخصات پروگرامر ۲

.ISP- دارای واسط  
- بدون نیاز به منبع تغذیه مجزا

.ISP Rescue Clock- دارای قابلیت 
- تنظیم نرم افزاری سرعت پروگرام کردن.

.DIP- دارای زیف سوکت برای میکروهای 
.USB- اتصال به کامپیوتر از طریق پورت  استاندارد یو اس بی 

- قابلیت به روز رسانی پروگرامر به منظور پشتیبانی از میکروهای جدید.
.BASCOM-AVR , CodeVisionAVR, ATMEL Studio- شناسایی پروگرامر توسط نرم افزارهایی از قبیل 

)، و توزیع های مختلف لینوکس 64bit,32( و،XP و 7 و 8و 10 و تمامی سیستم عامل های  رایج  ویندوزPC , Laptop- سازگار با انواع 
.mega , tiny , 90s پروگرام می شوند شامل میکروهای SPI که به صورت AVR- پروگرام تمامی میکروکنترلرهای 

- تامین ولتاژ مورد نیاز میکرو در هنگام پروگرام کردن در صورت نیاز.
 میکروکنترلر.‌FLASH , EEPROM- برنامه ریزی حافظه های 

 سانتی متر.7.5x4cm- ابعاد کوچک 
- امکان برنامه ریزی تمامی فیوزبیتها.

- محافظت در برابر اتصال کوتاه.
.USB1.1 ,USB2.0- سازگار با 

 ولت.5- ولتاژ پروگرام کردن: 

Key Features
• Short-circuit protection

• Programming voltage: 5V

• Target interface protection

• Programs both flash and EEPROM

• Upgradeable for future device support

• USB 2.0 compliant (full speed, 12Mbps)

• Supports fuses and lock bit programming

• 4MHz ISP Rescue Clock (for mis-set fuses)

• Powered from USB, does not require external power supply

• Adjustable ISP programming speed (50Hz to 8MHz SCK frequency)
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- اجزاء پروگرامر۳

 برای اتصال پروگرامر به پورت یو اس بی کامپیوتر.Micro USBکانکتور )1
 با دو عملکرد متفاوت (توضیحات بیشتر در بخش های بعد):S1کلید فشاری )2

 بروزرسانی پروگرامر (وقتی جامپرJ1.(سرجای خود قرار داشته باشد 
 تغییر مد عملیاتی پروگرامر (وقتی جامپرJ1.(از سرجای خود برداشته شود 

 را تعیین می کند.S1 که نقش کلید J1جامپر )۳
 برای پروگرام کردن میکروهایی که بر روی زیف سوکت قرار نمی گیرند.ISP 2×۳باکس هدر استاندارد )۴
 (توضیحات بیشترRescue Clock مگاهرتز به منظور استفاده به عنوان ۴ دارای پالس ساعت CLKاتصال )۵

).۵.۵در بخش 
). این کلید می تواند در دو وضعیت مختلفPower Select (کلید کشویی انتخاب تغذیه ی میکروکنترلر)۶

قرار گیرد:
USB  POWER: انکتورJJبا کشیدن این سوئیچ به سمت چپ (به سمت ک USB انگرJJنش (USBنJJروش 

 از پروگرامر تامین شده و نیازی به منبJJع۴شده و ولتاژ تغذیه میکروکنترلر متصل به باکس هدر شماره 
 ولت می باشد.VCC = 5تغذیۀ جداگانه برای روشن کردن میکروکنترلر نیست. این ولتاژ برابر 

TARGET  POWER انگرJJبا قرار گرفتن کلید در سمت راست و خاموش شدن نش :USBعJJد از منبJJبای ،
 استفاده شود.۴ ولت برای روشن کردن میکروکنترلر متصل به باکس هدر شماره ۵تغذیه جداگانه ی 
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 کامپیوتر، به پایه ی شماره یUSB ولت پورت ۵ عملکرد این کلید در  واقع قطع یا وصل نمودن ولتاژ تذکر:
 می باشد. به عبارت دیگJJر، ایJن کلیJJد هیJJچ تJأثیری بJJر روی ولتJJاژ اعمJJالی بJJه پایه هJJایISP باکس هدر 2

زیف سوکت نداشته و ولتاژ تغذیه ی میکروی قرار داده شده بر روی زیف سوکت، فارغ از وضعیت ایJJن کلیJJد،
همیشه از پورت یو اس بی تأمین می گردد و قابل تغییر توسط کاربر نیست.

 پایه (نحJJوه ی قJJرار دادن انJJواع میکJJرو، در۴۰ پایه تا ۸زیف سوکت برای پروگرام کردن میکروهای دیپ از)۷
قسمت پایین پروگرامر ترسیم شده است).

 مگاهرتز موجود بر روی پروگرامر، از پایه هJJای زیJJف۴ برای قطع و وصل نمودن اتصال کریستال J2جامپر )۸
).۴.۴ بخش سوکت (توضیحات بیشتر در

انتخاب منبع تغذیه میکروکنترلر. اگر این نشانگر روشن باشد تغذیه ی میکJJروی متصJJل بJJه:  آبینشانگر)۹
، از پروگرامر تامین می شود.۴باکس هدر شماره ی 

 (اگJJر چJJراغپروگرامر در حال پروگرام کردن میکرو و یا تبادل داده با کJJامپیوتر می باشJJد.:  قرمزنشانگر )1۰
سبز هم روشن باشد). اگر چراغ قرمز به تنهایی روشن باشد (چراغ سبز خاموش باشد) حاکی از عدم نصب

 و اتصال میکرو به کامپیوتر است؛ کل یعنی عدم شناسایی پروگرامر.USBدرایورها و یا مشکل در کابل 
 روشن بودن و آماده به کار بودن پروگرامر را نشان می دهد.: سبزنشانگر)11

 بیتی دارای این پروتکل8 های AVR برای پروگرام کردن ISPنمای باکس هدر  استاندارد  

ISP نحوۀ اتصال کانکتور
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- راه اندازی و استفاده از پروگرامر۴

Atmel  استفاده در محیط ۱.۴ Studio

پس از نصب برنامه، با اتصال پروگرامر به کامپیوتر، می توانید از آن در محیJJط اسJJتودیو اسJJتفاده نماییJJد. (به منظJJور
ایJJن کلیJJک کنیJJد. و یJJا از این لینکدریافت رایگان آخرین نسخۀ این نرم افزار از سایت شرکت میکروچیپ، بر روی 

 داخلی دریافت کنید.)لینک

جهت نصب اتمل استودیو، بهتر است ویندوز در حالتی قرار گیرد که مانع نصب درایورهJJای سJJخت افزاری نشJJود. در
 توضJJیح داده شJJده و سJJپس نصJJب اتمJJل اسJJتودیو انجJJام۸ادامه نحوه انجام چنین کاری برای نسخه ای از ویندوز 

می شود. برای سایر نسخه های ویندوز نیز روندهای مشابهی طی می شJJود کJJه بJJا جسJJتجو در اینJJترنت قابJJل یJJافتن
می باشد.

Windows 8 روند نصب اتمل استودیو تحت سیستم عامل ویندوز  ۱.۱.۴

 تنظیمات امنیتی به گونه ای اسJJت کJJه امکJJان نصJJب درایورهJJای ثبJJت نشJJده در1۰ و یا 8در سیستم عامل ویندوز 
Atmelمایکروسافت وجود ندارد. از این رو در هنگام نصب برنامۀ   StudioبJJر نصJJه پروگرامJJوط بJJدرایورهای مرب 

نخواهند شد. برای رفع این محدودیت و مشکل، پیش از نصب این برنامه مراحل زیر را به ترتیJJب انجJJام دهیJJد. (در
حالی که پروگرامر به کامپیوتر متصل نباشد.)

) نشJJانگر مJJاوس را در گوشJJۀ سJJمت راسJJت و پJJایین1
صفحه نمایش قرار دهید تا نJJوار عمJJودی سJJمت راسJJت

Settingsصفحه باز شود. در ایJJن نJJوار بJJر روی گزینJJۀ 

کلیک کنید.

 را کلیک کرده، در قسمت راست پنجره به انتهای پایین پنجره رفته و دکمJJۀGeneralرۀ باز شده گزینۀ ) از پنج2
Restart now.را فشار دهید 
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را انتخاب کنید. Troubleshoot) گزینۀ 3

را. Advanced options) و اکنون گزینۀ 4

 انتخاب گردد. Startup Settingsرۀ بعد هم ) از پنج5
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 کJJامپیوتر Restart) در مرحلۀ بعد با فشردن دکمJJۀ 6
شما مجددا  راه اندازی می شود.

 را فشار دهید تا گزینۀ7) پس از راه اندازی مجدد سیستم و نمایش صفحۀ زیر، از اعداد صفحه کلید عدد 7
“Disable driver signature enforcement”.انتخاب شود 

 را نصب کنید. و مطمئن شوید که در طول مراحل نصب اگر در موردAtmel Studio یا AVR Studio) اکنون 8
اب شده باشد. انتخInstall/upgrade USB Driverنصب درایور سؤال شد، گزینۀ 

) اگر طی مراحل نصب  این نرم افزارها، از طرف سیستم9
عامJJل وینJJدوز سJJؤالی در مJJورد تأییJJد نصJJب درایورهJJا

گزینۀ  شد،  Install this driver software”پرسیده 

anyway”.را انتخاب نمایید 
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با نصب اتمل استودیو، درایورهای مربوط به پروگرامر نیز بJJه صJJورت خودکJJار نصJJب می شJJوند و تنهJJا کJJافی اسJJت
پروگرامر را به کامپیوتر متصل نمایید.

Atmel برای استفاده از پروگرامر در محیط  Studioبه منوی 

Tools → AVR Programming

AVRISPرفته و گزینه   mkII را برای Tool .انتخاب کنید DeviceرارJJه قJJد کJJهم باید نام میکروکنترلری باش 
است پروگرام شود.

، نرم افزار کنترل پروگرامر را به دست  گرفته و آماده پروگرام کردن میکروکنترلر مJJوردApplyحال با فشردن دکمه 
نظر می شود.

SPIتغییر سرعت پروگرام کردن در حالت 
(این مقدار باید کمتر از یک چهارم سرعت کلک میکرو باشد)
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مشخصات میکروی مورد نظر

صفحۀ مربوط به تغییر مقادیر فیوز بیت ها

@avr_mkii                                                             10



 Mini MKII_LC Programmer User Manual V1.1                                       MkII_LC  دفترچه راهنمای پروگرامر 

۲.۱.۴ تذکر
) اگر پس از نصب  صحیح اتمل استودیو، باز هم پروگرامر برای سیسJJتم عامل قابJJل۷ و ۸ (و یا 1۰در ویندوز 

شناسایی نبود و چراغ قرمز روشن باقی ماند بدون اینکه چراغ سبز روشن شJJود، مراحJJل نصJJب درایJJور را بJJه
روشی که به طور مختصر در ادامه به آن اشاره می شود انجام دهید: 

deviceحذف و پاک کردن تمامی درایورهای پروگرامر، از طریق •  managerرJJو کلیک راست ب 
 (در حالی که پروگرامر به کامپیوترdelete و Uninstallروی گزینه مربوط به پروگرامر و انتخاب 

متصل است.

 در صورت فعال بودن. بهتر است انجام شود هرچند ضروری نیست)BitLocker(متوقف نمودن •
 راه اندازی مجدد ویندوز در مد: پشتیبانی از نصب درایورهای فاقد مجوز، از طریق انتخاب گزینه ی•

زیر، از پانل سمت راست ویندوز:

PC-Settings → Update/Recovery → Recovery → Extended Start

؛ start windows without driver sign checkو انتخاب گزینه 
(در ویندوزهای مختلف ممکن است متفاوت باشد. انجام این مرحلJJه هJJم گرچJJه معمJJول  ضJJروری

نیست و عدم انجام آن مشکلی ایجاد نمی کند اما توصیه می شود)

و از حالت فشرده خارج کردن آن. LIBUSBدانلود •

 موجJJود در پوشJJه یbin موجود در پوشه ای به نJJام inf-wizard.exe اجرای فایل (اتصال پروگرامر و)•
 انتخاب نام پروگرامر از لیست؛ زدن دکمه تأییدبال؛ و

(راه اندازی مجدد ویندوز. معمول  نیازی نیست)•

اکنون با باز کردن مجدد اتمل استودیو، پروگرامر آماده به کار خواهد بود.
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CodeVisionAVRبه کارگیری در محیط   ۲.۴

Atmel پیش از آنکه بتوانید از پروگرامر در محیط کدویژن استفاده نمایید، لزم است نرم افزار تذکر:  StudioزJJنی 
نصب شود و اطمینان حاصل کنید که قادر به کار با پروگرامر در محیط استودیو می باشید.

 دریافت نمایید.این لینکآخرین نسخه کدویژن را نیز می توانید از 

 به آدرس زیر رفته:CodeVisionAVRپس از نصب اتمل استودیو و کدویژن، در محیط کامپایلر 
Settings → Programmer  

 تغییر دهید.ATMEL AVRISP MkII - USB  را به AVR Chip Programmer Typeو مقدار 
اکنون می توانید در کد ویژن از پروگرامر استفاده کنید.
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BASCOM-AVRبه کارگیری در محیط   ۳.۴

دریافت نموده، و آن را این لینک )، درایورهای مربوطه را ازاین لینکپس از نصب نرم افزار بسکام (قابل دریافت از 
از حالت فشرده خارج نمایید. پروگرامر را به کامپیوتر متصل کنید.

پیش از نصب درایورهای سخت افزاری مورد نیاز بسکام که تنها یک بJJار انجJJام می شJJود، لزم اسJJت پروگرامJJر در
 راS1 را از جای خود خارج نموده و سJJپس کلیJJد J1وضعیت کاری  سازگار با بسکام قرار گیرد. بدین منظور جامپر 

 مرتبه چشمک خواهند زد که نشان دهنده ی قرار گرفتن پروگرامر در۵یک بار فشار دهید. حال چراغ های پروگرامر 
وضعیت سازگار با بسکام است. اکنون می توانید جامپر را در سرجای خود قرار دهید. درصورت نیاز به بازگشت به مد

 مرتبه چشJJمک2سازگار با اتمل استودیو و کدویژن، مجددا  جامپر را درآورده و کلید را بفشارید تا چراغ ها به تعداد 
بزنند. پروگرامر به صورت پیش فرض در مد سازگار با اتمل استودیو به مشتریان تحویل داده می شود.

deviceاکنون به   managerیرJJویندوز رفته، بر روی گزینه ی مربوط به پروگرامر کلیک راست کرده، و به مس 
زیر بروید:

Update Driver Software... → Browse my computer for driver software

 را انتخاب) BascomDriver( آدرس پوشه ی درایورهایی را که دانلود نموده و از حالت فشرده خارج کرده اید
 را فشار دهید و منتظر بمانید تا درایور نصب شود.Nextکرده و در نهایت دکمه 
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 اکنون پروگرامر آماده به کار در محیط بسکام می باشد. کافی است نJJام پروگرامJJر را از لیسJJت پروگرامرهJJا انتخJJاب
 قرار دهید.100ms را برابر timeoutکرده، و مقدار 

BASCOM-AVR → Options → Programmer → USBprog Programmer / AVR ISP mkII
برای بال بردن سرعت پروگرام، می  توانید این مقدار را کاهش دهید. اما اگر با کاهش آن، در هنگام پروگرام کردن بJJا

 در همۀ شرایط مناسب بوده و عملیات پروگJJرام100msپیام خطا مواجه شدید، مقدارش را افزایش دهید. معمول  
بدون خطا انجام خواهد شد.

هرگاه بعد از انجام مراحل فوق مایل بودید مجددا  از پروگرامر در نرم افزار اتمل استودیو یا کJJدویژن اسJJتفاده تذکر:
 بار چشمک بزننJJد و2 را یک بار فشار داده تا چراغ های پروگرامر S1 را درآورده، کلید J1نمایید، کافی است جامپر 

سپس جامپر را بر سرجای خود قرار دهید.

 روش کلی برای تغییر مد پروگرامر۱.۳.۴

درواقع اگر مراحل فوق یعنی نصب درایورهای سازگار با اتمل استودیو و نیJJز نصJJب درایورهJJای سJJازگار بJJا بسJJکام،
درایورها به درستی انجام گیرند، آنگاه روش کلی برای قرار دادن پروگرامر در وضJJعیت سJJازگار بJJا اتمJJل اسJJتودیو و

کدویژن، یا بسکام، همانی خواهد بود که در پاراگراف بال اشاره شد:
 چشJJمک زدنJJد، پروگرامJJر در بار2 و رها کردن آن؛ اگر چراغ ها S1، و یک بار فشار دادن دکمه J1درآوردن جامپر 

 قJJرار دارد. بعJJدبسکام چشمک زدند، پروگرامر در وضعیت سازگار با  بار۵ است؛ اگر اتمل استودیووضعیت سازگار با 
از انجام این کار می توان جامپر را سر جای خود قرار داد.
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 ISP Rescue Clockاستفاده از کلک خارجی -   ۴.۴
 تنظیم می شودExternal Clock به اشتباه برروی AVRگاهی فیوزبیت مربوط به انتخاب منبع کلک میکروهای 

و یا به دلیلی از قبیل قطع شدن اتصالت در حین پروگرام کردن، مقدار این فیوز بیتها در وضعیت نامشخصی قJJرار
می گیرد. در چنین شرایطی لزم است برای پروگرام کردن مجدد میکرو و تنظیم صحیح فیوزبیت هJJا از یJJک پJJالس

ساعت خارجی از قبیل سیگنال ژنراتور با دامنه ولتاژ مناسب استفاده گردد.
و دارا می باشد. از این پالس به 4MHz قابلیت تولید پالس ساعت مذکور را با فرکانس Mini MKII_LCپروگرامر 
 نام برده می شود.Recovery Clock یا Rescue Clock Sourceاصطلح 

XTAL1 در بالی پروگرامر مشخص شده است را بJJه پایJJۀ CLKبرای استفاده از این پالس ساعت، نقطه ای که با نام 
ISP نیز به جایی وصل نمی شJJود. فرکJJانس پروگرامینJJگ یJJا همJJان XTAL2میکروی مورد نظر متصل نمایید. پایۀ 

Clock  125 را نیز بر روی )9(تصویر صفحۀkHz.تنظیم کنید 

 به پایه های میکروی مورد نظر شما کJJهJ2 مگاهرتز است که از طریق جامپر ۴ پروگرامر، دارای یک کریستال :تذکر
بر روی زیف سوکت قرار می دهید متصل می شود. اگر به هر دلیلی مایلید اتصال ایJJن کریسJJتال بJJا میکJJرو را قطJJع

 را از جای خود خارج کنید.J2نمایید، کافی است جامپر 
 برای پروگرام کردنExternal Clockو طبق این توضیحات، واضح است که اگر می خواهید بجای این کریستال، از 

 را ازCLK از جای خود، باید J2میکروی قرار داده شده بر روی زیف سوکت استفاده کنید، علوه بر درآوردن جامپر 
 میکروی روی زیف سوکت متصل کنید. این کار را می توانید از طریق متصJJلXTAL1طریق یک تکه سیم به پایه ی 

 انجام دهید.J2 به پایه ی سمت چپ جامپر CLKکردن 
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.  چند نکته و رفع مشکلت احتمالی۵ 

اگر وقتی که پروگرامر را به کامپیوتر متصل می کنید چراغ قرمز آن به طور مداوم روشن باقی بماند، نشانگر
آن است که درایورهای آن به درستی نصب نشده اند و سیسJJتم عامل هنJJوز پروگرامJJر را نمی شناسJJد. علJJت

 و یا نصب ناقص آن می باشد. معمول  بJJا نصJJب کامJJل وAtmel Studioعمده این مشکل نیز عدم نصب 
مجدد این نرم افزار، مشکل مذکور برطرف می گردد. در غیر این صورت مشکل مربوط بJJه سیسJJتم عامل و یJJا

سخت افزار کامپیوتر می باشد و یا اتصال پروگرامر به رایانه دارای مشکل و قطعی است.

 بار پشت سر هم چشمک زدند، پروگرامر در مد سازگار با2با اتصال پروگرامر به کامپیوتر، اگر چراغهای آن 
 بار متوالی چشمک زدند، در حالت سازگار با بسکام. به منظور تغییر و۵اتمل استودیو و کدویژن است؛ و اگر 

 را یک بار بفشارید.S1 را درآورده و دکمه J1جابه جایی بین این دو مد عملیاتی، کافی است جامپر 

هJJت کJJانگر آن اسJJد، بیJJاقی مانJJاگر در هنگام پروگرام کردن، چراغ قرمز پروگرامر به مدت طولنی روشن ب
خطایی در پروگرام کردن پیش آمده است. در این حJJالت پروگرامJJر را از کJJامپیوتر جJJدا نمJJوده، برنJJامه را

ببندید و عملیات پروگرام را مجددا  از نو شروع نمایید.

 همان طور که قبل تذکر داده شد، فرکانسISP  ClockرویJJانس کلک میکJJباید کمتر از یک چهارم فرک 
مورد نظر باشد.

 اگر پروگرامر قادر به اتصال و پروگرام کردن میکرو نباشد، آن قدر فرکانسISP ClockاJJرا کاهش دهید ت 
پروگرامر بتواند به پروگرامر متصل شود.

نصب و راه اندازی و نیز استفاده از پروگرامر، بر روی انواع سیستم عامل ویندوز از جمله :تذکر XP، 7، 8،
 آزمایش شده و صحت عملکرد آن مورد تأیید قرار گرفته است. نیز، تمامی پروگرامرها پیش از ارسJJال10 و

به مشتریان و یا تحویل به نمایندگان فروش، حداقل یک بار مورد تست قJJرار گرفته انJJد. لJJذا تولیJJد کننJJده
هیچ گونه مسئولیتی در قبال مسائل نرم افزاری کاربران و مشکلت احتمJJالی هنگJJام نصJJب درایJJور برعهJJده

نخواهد گرفت و از ارایه ی راهنمایی های فراتر از آنچه در این دفترچه راهنما ذکر شده، معذور است.
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Firmware Update. به روز رسانی پروگرامر - ۶

 ب##ر روی ک##امپیوتر ش##ما نص##بFLIPبه منظور به روز رسانی یا تغییر ثابت افزار یا همان فرم ور پروگرامر، باید نرم افزار 
 قاب##ل دری##افتاین لینک توسعه داده شده، از ATMEL که توسط شرکت FLIPشده باشد. آخرین نسخه از نرم افزار 

است. در ادامه به چگونگی به روز رسانی پروگرامر توسط این نرم افزار می پردازیم: 

 (و یا ب##رای دری##افت فای##لپروگرامر قابل دریافت استکانال ایتای  یا سایت‌وب جدید ترین فایل  به روز رسانی از نکته:
بدون نیاز به اینترنت، نشانگر موس را بر روی آیکون زیر  قرار داده، و طبق دستور نشان داده شده عمل کنید).

Mini ثابت افزار پروگرامر  MKII_LC
.

 واقع در سمت چپ بالی پروگرامر را فشار دهید. با اینS1 در سر جای خود قرار دارد، دکمهJ1در حالی که جامپر 
کار هر سه چراغ پروگرامر خاموش شده و نشان دهنده آن است که پروگرامر آم##اده دری##افت نس##خه جدی##د ف##رم ور

می باشد، البته در صورتی که سیستم عامل نیز پروگرامر را در این وضعیت شناخته باشد:
Deviceبرای بررسی این موضوع در سیستم عامل ویندوز به قس##مت   Managerرفت##ه و اگ##ر پروگرام##ر توس##ط 

کامپیوتر شما شناخته نشده است یعنی با علمت اخطار زرد رنگ نشان داده شده، درایور مربوط به وض##عیت ب##ه روز
رسانی آن را طبق مراحل زیر نصب کنید.

 را انتخاب نمایید.Update Driver Software بر روی آن کلیک راست کرده و گزینه Device Managerدر 
 را انتخاب کنیدBrowse my computer for driver softwareره باز شده گزینه - از پنج

C:\Program Files\Atmel\Flip 3.4.7\usb- در پنجره باز شده آدرس روبه رو را وارد نمایید:              
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 بر روی سیستم شما متفاوت است آدرس بال را متناسب با آن تغییر دهید.FLIPاگر مکان نصب نرم افزار 
 عملیات نصب شروع شده و پس از چند لحظه درایور نصب شده و پروگرامر آم##اده ب##ه روزNext- با فشردن دکمه 

 خواهد بود.FLIPرسانی توسط نرم افزار 
اکنون مراحل کار را طبق تصاویر زیر انجام دهید:

 را اجرا نمایید.FLIPنرم افزار 
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 را انتخاب کنید.AT90USB162 گزینه Device→ Select  کلیک کنید و یا از منوی chipبر روی آیکون 

 را فشار دهید.OKدکمه 

 را انتخاب کرده و به پروگرامر متصل شوید.USB کلیک کنید و از منوی ظاهر شده گزینه USB cableبر روی آیکون 
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فایل فرم ور جدید را بارگذاری کنید:

File → LOAD HEX file یا منوی LOAD hex fileآیکون 

 را از صفحه اصلی نرم افزار فشار دهید.RUNسپس دکمه 

Startاکنون پروگرامر شما به روز رسانی شده است. دکمه   Applicationرا فشار دهید یا پروگرامر را ی##ک ب##ار از 
کامپیوتر جدا نموده و مجددا  متصل نمایید تا در وضعیت پروگرام کردن قرار گیرد.

ـــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــ

شماره تماس

09138051704
09360023323

 Eitaa
@avr_mkii
Web Site
www.avrmkii.tk
Technical Support
avrmkii@gmail.com

و اعمل لخرتك كأنكك توت غداو اعمل لخرتك كأنكك توت غدا

.و براى آخرت خود چنان عمل نا كه گوئى فردا خواهى مرد

 تمامی حقوق محفوظ است.۱۳۹۷© 

mailto:avrmkii@gmail.com
http://www.avrmkii.tk/
https://eitaa.com/avr_mkii
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